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General Instructions
COMPLETIONS REPORT
The completions report consists of a record of every degree or certificate awarded
(undergraduate, graduate, and first-professional) by the institution, exported into an Excelcompatible file format (e.g. .XLS, .CSV, or tab-delimited). Data should be reported on ALL
students graduating from an institution, not just TELS recipients.
General Guidelines
1.
A report will be run once per year for the prior Summer, Fall, and Spring terms.
Reporting Dates
June 15th
P

Definitions
Term:

P

A term extends from the first official day of activity up to the first official
day of activity of the following term. The school year will consist of three
regular terms (fall, spring, and summer).

Submitting Completions Data to TICUA
To ensure the privacy of completions data during transmission, all completions reports should
be submitted via TICUA’s secure web site. The latest version of the instructions on accessing
this web site can be located on TICUA’s Research web page located at
http://www.ticua.org/research/
How Data Will Be Used
The data will be used to report institutional information in our annual Characteristics report
and to satisfy institutional reporting requirements relating to TELS awards. The data will also
be used to highlight key trends and important policy issues facing private colleges and
universities. The data replace a number of former surveys conducted by TICUA.
Data Privacy and Security
TICUA has taken all reasonable steps to ensure that the data shared with the Association are
secure, and that access to the data is restricted.
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ENROLLMENT AND FINANCIAL AID REPORT
The enrollment and financial aid report consists of a record of every student (undergraduate,
graduate, and first-professional) attending the institution in a particular term exported into an
Excel-compatible file format (e.g. .XLS, .XLSX, .XLSM, .CSV, tab-delimited). Except where
noted, data should be reported on all students. Please use the sheet on the enrollment and
financial aid report template titled “Blank Enrollment Report” to report the students. You
should check TICUA’s research web page each semester to make sure you have the latest copy
of the reporting template – not doing so may require revisions of your submission due to
missing /changed data elements.
General Guidelines
1 Enrollment and financial aid data shall be reported in the term in which the ending
date of the course falls.
2 A report will be run for each term (fall, spring and summer).
3 For consistency, please use data from the census or report date(s) at your institution.
Reporting Dates
Fall Spring Summer -

October 1st
March 15th
August 15th
P

Duplicate Records Check
Student records will be checked to determine whether a duplicate record exists in the file. The
student identifier fields (STDTNU and INTNUM) are used to match the records.
Submitting Enrollment and Financial Aid Data to TICUA
To ensure the privacy of enrollment and financial aid data during transmission, all reports
should be submitted via TICUA’s secure web site. The latest version of the instructions on
accessing this web site can be located on TICUA’s research web page located at
https://ticua.org/page/datacollection
A data-checking program has also been created to help ease the reporting process – it is
located on TICUA’s research page as well. Please make sure to run this program before
submitting your reports – this will greatly cut down on the amount of time it takes to finish the
process.
How Data Will Be Used
The data will be used to report institutional information in our annual Characteristics report to
satisfy institutional reporting requirements relating to TELS awards. The data will also be used
to highlight key trends and important policy issues facing private colleges and universities. The
data replace a number of former surveys conducted by TICUA.
Data Privacy and Security
TICUA has taken all reasonable steps to ensure that the data shared with the Association are
secure, and that access to the data is restricted.
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Data Element Directory ~ Completions
Institution FICE Code (FICECODE)
Description
The six-digit FICE code corresponding to your institution. FICE codes for Tennessee and
other institutions can be found at http://www.ticua.org/research/data_collection.

Valid Responses
Six-digit number in form ######

Examples
003258
003854

Edit

An error will occur if the field is not equal to a valid six-digit FICE code.

Internal Student Number (INTNUM)
Description
The institution internal student number must be unique for each student enrolled. All
students must have either a STDTNU or an INTNUM. Internal student numbers should
be consistent across a student’s career (ie: they should have the same INTNUM for all
semesters enrolled). They may contain a mix of characters and digits, to a maximum
length of 25 characters.

Valid Responses
Unique number.

Examples
123456789
123-45-6789
LMU12345678

Edit
An error will be generated if the field is not a unique value.
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Student Number (STDTNU)
Description
The student’s Social Security number is used for the student identification number. If a
student does not have a Social Security number, please contact TICUA with your
procedure for assigning a student identification number. The student number must be
unique for all students. Required for all TELS, TN Promise, & TN Reconnect students.
In addition, campuses participating in P20 Connect, Tennessee’s longitudinal data
system, should report the student’s Social Security number in this field for all students.

Valid Responses
Unique nine digit number in form ###-##-#### or #########.

Examples
123-45-6789
987654321

Edit
The field must be a unique nine-digit number in form ######### or ###-##-####.

Year of Degree Award (AWARDEDYEAR)
Description
The year in which the student actually received their degree – may or may not be the
same as the completion year.

Valid Responses
Four-digit year in form ####

Examples
2014
2015

Edit
An error will be generated if the awarded year is not a four digit integer.
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Term of Degree Award (AWARDEDTERM)
Description
The term in which the student actually received their degree – may or may not be the
same as the completion term.

Valid Responses
Fa, Sp, or Su

Examples
Fa
Su

Edit
An error will be generated if the awarded term is not one of the valid responses listed
above.

Degree Level (DEGREELEV)
Description
The type of degree awarded – Associate’s, Bachelor’s, Master’s, Doctoral, FirstProfessional Degree, Pre-Baccalaureate Certificate, Post-Baccalaureate Certificate, or
Post-Master’s Certificate.
Note that first-professional degrees and certificates are only awarded in the following
fields:
Chiropractic (D.C., D.C.M.)
Pharmacy (B. Pharm, Pharm D.)
Dentistry (D.D.S, D.M.D.)
Podiatry (Pod. D. D.P., D.P.M.)
Medicine (M.D.)
Veterinary Medicine (D.V.M.)
Optometry (O.D.)
Law (L.L.B., J.D.)
Osteopathic Medicine (D.O.)
Divinity/Ministry (B.D., M. Div.)
Rabbinical and Talmudic Studies (M.H.L, Rav)

Valid Responses
(adapted from the Classification of Instructional Programs:2000 Edition)
Three-letter code in form XXX corresponding to the type of degree listed above – ASO,
BAC, MAS, DOC, FPD, UGC, PBC, or PMC.

Examples
8

ASO
FPD
DOC

Edit
An error will be generated if the degree level is not one of the valid responses listed
above.

First and Second Major Fields (MAJOR1 and MAJOR2)
Description
The first and second academic major of the student. The major is reported using the
appropriate six digit code from the Classification of Instruction Programs, 2010
developed and published by the National Center for Educational Statistics. Links to the
CIP2010 can be found https://ticua.org/page/datacollection. MAJOR1 is required for
all students, MAJOR2 is optional.

Valid Responses
Six-digit code from the 2010 Classification of Instructional Programs (CIP).

Examples
12.2210
541100

Edit
An error will be generated if MAJOR1 and MAJOR2 are not valid CIP2010 codes in the
form ##.#### or ######.

GPA – Final Cumulative TELS (TELSGPA)
Description
Required for all TELS students. This is the student’s final TELS GPA at graduation.
Defined in the same manner as the GPATELS variable in the enrollment report.
REMINDER: ALL CREDITS ATTEMPTED AT OTHER POSTSECONDARY INSTITUTIONS
MUST BE INCLUDED IN THIS CALCULATION, EVEN IF THEY DO NOT COUNT
TOWARD GRADUATION.

Valid Responses
Numeric on a 4.0 scale (e.g. 2.50 or 3.24) with up to two digits to the right of the
decimal place.
9

Examples
3.00
2.98

Edit
An error will be generated if TELSGPA is missing for any TELS students.

GPA – Final Cumulative Home (CUMGPA)
Description
Student’s final cumulative GPA from the reporting institution. Required for all students.
Defined in the same manner as the GPAHME variable in the enrollment report.

Valid Responses
Number on a 4.0 scale with up to two digits to the right of the decimal place.

Examples
3.75
0.75

Edit
An error will be generated if CUMGPA is missing for any student.

Credit Hours Earned – Final Cumulative Home (CUMHRS)
Description
Total number of credits earned at or accepted by the reporting institution at graduation.
Required for all students. Defined in the same manner as the ERNHME variable in the
enrollment report.

Valid Responses
Number with up to two digits to the right of the decimal place.

Examples
110.25
17.25
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Data Element Directory ~ Enrollment
Institution FICE Code (FICECODE)
Description
The six-digit FICE Code corresponding to your institution. Required for all students.
FICE codes for Tennessee and other institutions can be found at
https://ticua.org/page/datacollection.

Valid Responses
Six-digit number in form ######

Examples
003258
003854

Edit
An error will occur if the field is not equal to a valid six-digit FICE code.

Internal Student Number (INTNUM)
Description
The institution internal student number must be unique for each student enrolled. All
students must have either a STDTNU or an INTNUM. Internal student numbers should
be consistent across a student’s career (ie: they should have the same INTNUM for all
semesters enrolled). They may contain a mix of characters and digits, to a maximum
length of 25 characters.

Valid Responses
Unique number.

Examples
123456789
123-45-6789
LMU12345678

Edit
An error will be generated if the field is not a unique value.
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Student Number (STDTNU)
Description
The student’s Social Security number is used for the student identification number. If a
student does not have a Social Security number, please contact TICUA with your
procedure for assigning a student identification number. The student number must be
all numeric and unique. All students must have either a STDTNU or an INTNUM.
Please note: For all TELS, TN Promise, and TN Reconnect students, this field must be
populated with the student’s Social Security number. In addition, campuses
participating in P20 Connect, Tennessee’s longitudinal data system, should report the
student’s Social Security number in this field for all students.

Valid Responses
Unique nine-digit number in form ###-##-#### or ########.

Examples
123456789
123-45-6789

Edit
An error will be generated if the student number is not a unique nine-digit number in
form ###-##-#### or ########, or if the field is omitted for a student receiving a TELS
award.

Registration Term (TERM)
Description
The term for which the report is being generated – fall, spring, or summer. Required for
all students.

Valid Responses
Fa, Sp or Su

Examples
Sp
Su

Edit
An error will be generated if the field is not one of the above valid responses.
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Registration Year (YEAR)
Description
The year for which the report is being generated. Required for all students.

Valid Responses
Four digit year in form ####

Examples
2015
2016

Edit
An error will be generated if the field is not a four digit integer.

Race/Ethnicity (RACE)
Description
Indicates a student’s racial/ethnic origin. The code is designed to provide information in
the form collected by IPEDS. Please refer to IPEDS rules regarding reporting
race/ethnicity. Required for all students.
Numeric
Code
1
U

Race/Ethnicity
Non-resident
Alien

Definition
A person who is not a citizen or national of the United
States and who is in this country on a visa or
temporary basis and does not have the right to remain
indefinitely.
U

U

2

Black or AfricanAmerican

A person having origins in any of the Black racial
groups of Africa.

3

American Indian
or Alaskan Native

A person having origins in any of the original peoples of
North and South America (including Central America)
who maintains cultural identification through tribal
affiliation or community attachment.

4

Asian

A person having origins in any of the original peoples of
the Far East, Southeast Asia, or the Indian
Subcontinent, including, for example, Cambodia,
China, India, Japan, Korea, Malaysia, Pakistan, the
Philippine Islands, Thailand, and Vietnam.

5

Hispanic or
Latino

A person of Cuban, Mexican, Puerto Rican, South or
Central American, or other Spanish culture or origin,
regardless of race.
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6

White

A person having origins in any of the original peoples of
Europe, the Middle East, or North Africa.

7

Unclassified

Students who classify themselves as “human”, “none of
your business”, etc. All reasonable efforts should be
made to place the student in one of the other categories
before using this one.
Undocumented students should be reported in this
category.

8

Two or more
races

Students who classify themselves as more than one
race

9

Native Hawaiian
or Other Pacific
Islander

A person having origins in any of the original peoples of
Hawaii, Guam, Samoa, or other Pacific Islands.

Valid Responses
One-digit numeric code corresponding to above.

Examples
2
3

Edit
An error will be generated if the field is not one of the above valid responses. An error
will also be generated if a student is listed as a US citizen but has a RACE value of 1.

Gender (GENDER)
Description
The student’s gender - male, female, or unknown. Required for all students.

Valid Responses
M, F or U

Examples
M
U

Edit
An error will be generated if the field is not one of the above valid responses.
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Citizenship (CITZEN)
Description
Classification of each student according to their U.S. citizenship status. Use PR for
Permanent Residents. Required for all students.

Valid Responses
Y, N, or PR

Examples
Y
N
PR

Edit
An error will be generated if the field is not one of the above valid responses. If a
student is listed as CITZEN = “Y” or “PR”, then their PCNTRY value must be equal to
“US”.

Resident Status – Lottery (RESIDT)
Description
This is the Tennessee Education Lottery Definition of Residency. Required for all
students. Students must be a Tennessee resident for one year as of May 1 immediately
preceding enrollment in an eligible postsecondary institution and be a Tennessee
resident as defined by the Board of Regents Chapter 0240-2-2, classifying students as
in-state (I) or out-of-state (O).
Note: If a student living out of state (for example, in a TN border state) is receiving a
TELS award, then they would be classified as in-state.
Because this data element is based on the student’s residency prior to enrollment in a
postsecondary institution, the value will not change following a change in permanent
address (ex. a parent moving out-of-state).

Valid Responses
I or O

Examples
O
I

Edit
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An error will be generated if the field is not one of the above valid responses.

Date of Birth (BIRTHD)
Description
The student’s date of birth. Required for all students.

Valid Responses
Date in form MM/DD/YYYY

Examples
01/22/1997
07/21/1956

Edit
An error will be generated if the field is not a valid date.

Permanent Address ZIP Code (PZIP)
Description
This is the student’s permanent ZIP code at the time of current registration. It is the
home ZIP code when he or she is not a student. An unemancipated person whose
parent is out of the country on temporary assignment, such as military, would use the
appropriate state or Tennessee code for permanent ZIP code. This data element should
be reported for US citizens and permanent residents only. Nine digit ZIP codes (+4’s)
should be stripped to their first 5 digits.

Valid Responses
Numeric code in form #####

Examples
37024
35322

Edit
An error will be generated if the field is not a valid five-digit zip code.
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Permanent County Code (PCOUNTY)
Description
This is the code for the student’s permanent county of residence at the time of current
registration according to the county codes list at:
http://www.ticua.org/page/datacollection. This data element should be reported for TN
residents, and for students who are living in a border state and are receiving the lottery
scholarship. For example, if a student lives in Jackson County (in Alabama) then the
county code for this student would be AL071.

Valid Responses
Three-digit code corresponding to Tennessee county name OR five-digit code
corresponding to student’s state and county number for students living in border
states.

Examples
015
MS033
999

Edit
An error will be generated if the field is not a three-digit integer or five-digit code as in
the examples above.

Permanent Address State Code (PSTATE)
Description
This is the student’s permanent state code at the time of current registration. Required
for all students with a permanent country code (PCNTRY) of ‘US’. A complete list of all
valid state codes can be found at https://ticua.org/page/datacollection.

Valid Responses
Two letter text code.

Examples
TN
AZ

Edit
An error will be generated if a student has a permanent country of other than the US
but has a PSTATE code listed or if a student has a permanent country of US and no
17

PSTATE code listed. An error will also be generated if the field is not a valid two-letter
text code.

Permanent Address Country Code (PCNTRY)
Description
This is the student’s permanent country code at the time of current registration.
Required for all students. It is the home country code when he or she is not a student.
An unemancipated person whose parent is out of the country on temporary assignment,
such as military, would use the appropriate state or Tennessee code for permanent
country code. Use the two-letter FIPS codes used for SEVIS (the Student and Exchange
Visitor Information System) reports. Access a list of these country codes in the Federal
Information Processing Standards Publication “Countries, Dependencies and Areas of
Special Sovereignty”. A list of country codes is available on our website at
https://ticua.org/page/datacollection.

Valid Responses
Two-letter text code.

Examples
US
BU

Edit
An error will be generated if the field is not a valid two-letter text code. An error will also
be generated if a student is listed as a US citizen but has a permanent country of other
than the US. An error will also be generated if a student has a permanent country of
“US” but has a race code of “1” (non-resident alien).

Student Level (SLEVEL)
Description
This data element indicates the student’s level. If a student is working toward a degree
or certificate at the reporting institution, the individual is classified according to the
level or progress within that program. Required for all students. If a student is not
working toward a degree or certificate at the reporting institution, the student is
classified as a continuing education student.
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Codes
U

Code

Student Level
U

U

Definition
U

Undergraduate Student Levels
1

Freshman

The term “freshman” is institutionally defined to
describe the level of a student working toward an
undergraduate degree or certificate.

2

Sophomore

The term “sophomore” is institutionally defined to
describe the level of a student working toward an
undergraduate degree or certificate.

3

Junior

The term “junior” is institutionally defined to describe
the level of a student working toward an undergraduate
degree or certificate.

4

Senior

The term “senior” is institutionally defined to describe
the level of a student working toward an undergraduate
degree or certificate.

5

Fifth-year
undergraduate

This term refers to students enrolled in programs which
normally take five years to complete, e.g. some
engineering programs or medical technology degrees. Do
not use “fifth-year undergraduate” to describe a student
who takes five years to complete a four-year degree.

6

Undergraduate special

This is a student who is (1) non-degree seeking and
holds no degree or certificate; or (2) non-degree seeking,
holding any level degree, but taking only courses for
undergraduate credit; or (3) non-degree seeking, holding
no bachelor’s degree, and taking courses for both
graduate and undergraduate credit; or (4) one seeking a
Technical Certificate of Credit.
*Dual Enrollment students should be reported in this
category.

Graduate Student Levels
7

Graduate special

A student who is (1) non-degree seeking, holding a
bachelor’s or higher degree, taking courses for graduate
credit only; or (2) non-degree seeking, holding a
bachelor’s or higher degree, taking courses for both
graduate and undergraduate credit; or (3) holding a
bachelor’s degree, and seeking a Graduate Certificate of
Credit.

8

Master’s candidate

A student who has been formally admitted to graduate
school for the purpose of pursuing a Master’s degree.

9

Specialist in Education
candidate

A student who has been formally admitted to a graduate
school for the purpose of pursuing Specialist in
Education degree.

10

Doctoral student, early
stage

A student who has been formally admitted to graduate
study and whose major academic endeavor consists of
19

formal course work directed toward fulfilling
requirements for a doctoral degree.
11

Doctoral student, late
stage

A student who has been advanced to candidacy for a
doctoral degree, or one whose principal academic
endeavor consists of independent study, research, or
work toward fulfilling requirements for a doctoral
degree.

12

Post-doctoral student

A student who holds a doctoral degree and who is
pursuing a program of study or training for which a
doctoral degree is requisite.

Professional degree student levels
13
First year professional
A student who has been accepted into a program leading
student
to the JD, MD, DDS, PharmD, OD, or DVM degree and
is in the first year of his studies toward that degree.
14

Second year
professional student

A student who has been accepted into a program leading
to the JD, MD, DDS, PharmD, OD, or DVM degree and
is in the second year of his studies toward that degree.

15

Third year professional
student

A student who has been accepted into a program leading
to the JD, MD, DDS, PharmD, OD, or DVM degree and
is in the third year of his studies toward that degree.

16

Fourth year
professional student

A student who has been accepted into a program leading
to the JD, MD, DDS, PharmD, OD, or DVM degree and
is in the fourth year of his studies toward that degree.

Graduate Medical Residency Student Level
17
First Year Resident
A person holding the MD, DDS, or DVM degree and who
Second Year Resident
has been admitted to advanced professional study in a
Third Year Resident
residency program and is in the first, second, third, or
Fourth Year Resident
fourth year of that study.
Non-degree Student Level
18
Continuing education
student

A student who is participating exclusively in individual
continuing education unit activities.

Valid Responses
Numeric code corresponding to categories above.

Examples
1
11

Edit
An error will be generated if the field is not one of the above valid responses.
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Registration Type (REGTYPE)
Description
This element is used to describe the current enrollment status of the student. Required
for all students. Students who do not fit in categories 1 – 4 should be classified as 6.
Code
1

Registration
Type
First-time
freshman (firsttime college
student)

Definition
A student who has not been previously enrolled for work
creditable toward a bachelor’s or associate degree or
certificate in any college, university, or technical institute
since they graduated from high school, but who is now
enrolled for work creditable toward such a degree. A firsttime college student be either full-time or part-time. This
code should be used only for the individual’s first term in
college; later terms are coded “6”.

2

First-time
graduate or
professional
student

A student who has not been previously enrolled for work
creditable toward an advanced degree at any university,
and who is enrolled for work creditable toward such a
degree. A first-time graduate or professional student may be
either full or part-time.

3

Transfer
student

A student who last attended another institution from which
credit is acceptable toward the degree or certificate in
progress by the student. This code should be used only for
the individual’s first term as a transfer student; later terms
are coded “6”.

4

Transient
student

A transient or term special student is one who is regularly
enrolled and in good standing at an institution other than
the reporting institution and who is taking a course(s) at
the reporting institution which he/she intends to transfer
to his/her regular institution.

6

Student not
classified in one
of the above
categories

Continuing students and students that do not fall into any
of the above categories (e.g. dual enrollment students).

As noted above, in most cases, codes 1, 2, and 3 should only be reported in the
individual’s first term in college. If, however, an individual’s first term is a summer
term, the individual may be reported again as a first-time student in the fall term.

Valid Responses
One-digit numeric code.

Examples
2
6
1
21

Edit
An error will be generated if the field is not one of the above valid responses.

Transfer Institution (TFICE)
Description
The most recent institution from which a student has transferred. If a student is
identified as a transfer student under the REGTYPE field (code 3), the appropriate
transfer institution code should be reported in this field.
Codes for all U. S. institutions can be found in the Higher Education Directory,
published by the Higher Education Publications, Inc.
A list of FICE Codes for Tennessee and other institutions can be found at
https://ticua.org/page/datacollection.
Alternate Responses:
If no FICE code exists for an institution, the alternate codes listed below may be used.
Code
F
T1
T2
F1
F2
999999
U

Transfer Institution
Foreign Institutions
Two-year public institutions
Two-year independent institutions
Four-year or more public institutions
Four-year or more independent institutions
Unaccredited US colleges & universities; Also a miscellaneous code to be
used as a last resort if the transfer institution is unknown
U

Valid Responses
Six-digit FICE code maintained by the National Center for Educational Statistics in form
######.

Examples
999999
007783

Edit
An error will be generated if student is listed as a first-semester transfer student
(FirstTR=”Y”), but does not have a TFICE code listed. An error will also be generated if a
code is listed, but it is not a valid six-digit FICE code or one of the alternate codes listed
above.
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Major of Study (MAJOR1)
Description
The first academic major of the student. The major is reported using the appropriate six
digit code from the Classification of Instruction Programs, 2010 developed and
published by the National Center for Educational Statistics. Links to the CIP2010 can
be found at https://ticua.org/page/datacollection.

Valid Responses
Six-digit code from the 2010 Classification of Instructional Programs (CIP).
Unknown/undeclared majors should be reported as 000000.

Examples
12.1111
332500

Edit
An error will be generated if the student major field is not a valid CIP code in the form
##.#### or ######. An error will also be generated if a student does not have a major
listed and their student level is greater than sophomore (SLEVEL > 2).

Credits Attempted - Cumulative Home (ATMHME)
Description
Total number of credits attempted at the reporting institution using institutional
guidelines. Required for all students. This incorporates all credits accepted by the
institution, including any transfer credits accepted.
Please note: this variable DOES NOT include the student’s current semester hours.

Valid Responses
Number with up to two digits to the right of the decimal place.

Examples
110.25
17.25
0.00

Edit
An error will be generated if ATMHME is missing.
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Cumulative Attempted TELS Credit Hours (ATMTELS)
Description
This is the Tennessee Education Lottery Definition of attempted credits. Required for
all TELS students.
Cumulative Attempted TELS Credit Hours includes all credits attempted AFTER high
school graduation, GED completion, or home school program completion, including
repeated courses, developmental and remedial courses, independent studies, distance
learning courses, internship and co-op programs, alternative programs, and courses
earned as a transient student; it excludes credits attempted BEFORE high school
graduation, GED completion, or home school program completion; it excludes credits
attempted as part of a certificate program unless these hours count toward graduation;
and it excludes audit hours and continuing education hours.
Please note: this variable DOES NOT include the student’s current semester hours.

Valid Responses
Number with up to two digits to the right of the decimal place.

Examples
110.25
17.25
0.00

Edit
An error will be generated if ATMTELS is blank for any TELS students.

Credits Earned - Cumulative Home (ERNHME)
Description
Total number of credits earned at or accepted by the reporting institution. Required for
all students.
Please note: this variable DOES NOT include the student’s current semester hours.

Valid Responses
Number with up to two digits to the right of the decimal place.

Examples
110.25
17.25
0.00
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Edit
An error will be generated if ERNHME is missing.

Current Term Credit Hours (CURHRS)
Description
The number of credit hours for which the student is enrolled at the institutionally
defined census or report date for the term reported. Required for all students.

Valid Responses
Number with up to one digit to the right of the decimal place.

Examples
110.0
17.5
0.0

Edit
An error will be generated if CURHRS is missing.

Remedial/Developmental Hours (RemDevHrs)
Description
Please indicate the number of credit hours students are enrolled in remedial and/or
developmental courses this semester. Required for all TELS students.

Valid Response
Numeric with up to one digit to the right of the decimal place.
U

Examples
0.0
3.5

Edit
An error will be generated if RemDevHrs is missing for any TELS students.

GPA – Cumulative Home (GPAHME)
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Description
Student cumulative GPA from the reporting institution. Required for all students. This
incorporates all credits accepted by the institution.

Valid Responses
Number on a 4.0 scale with up to two digits to the right of the decimal place.

Examples
3.75
0.75

Edit
An error will be generated if GPAHME is missing for any student.

GPA – Cumulative TELS (GPATELS)
Description
Required for all TELS students. This is the Tennessee Education Lottery Definition of
GPA.
The TELS GPA calculation is based on Institutional grading policy, but it must be on a
4 point scale. It must calculate GPA on all credits attempted AFTER high school
graduation, GED completion, or home school program completion, including repeated
courses, developmental and remedial courses, independent studies, distance learning
courses, internship and co-op programs, alternative programs, and courses earned as a
transient student EXCEPT for withdrawals and current incompletes; it excludes credits
attempted before high school graduation, GED completion, or home school program
completion; it excludes credits attempted as part of a certificate program unless these
hours count toward graduation; and it excludes audit hours and continuing education
hours. If your institution does not assign quality points to pass/fail courses, they may
be excluded from this calculation.
REMINDER: ALL CREDITS ATTEMPTED AT OTHER POSTSECONDARY INSTITUTIONS
MUST BE INCLUDED IN THIS CALCULATION, EVEN IF THEY DO NOT COUNT
TOWARD GRADUATION.

Valid Responses
Numeric on a 4.0 scale (e.g. 2.50 or 3.24) with up to two digits to the right of the
decimal place.

Examples
3.00
2.98
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Edit
An error will be generated if GPATELS is missing for any TELS students.

Month and Year of Initial TELS Award Receipt (InTELS)
Description
The first month and year a student receives a TELS award at any institution. Required
for all TELS students.

Valid Responses
Date in form MM/YYYY

Examples
12/2012
08/2014

Edit
An error will be generated if a student has a value greater than zero in HOPESC or
HOPEGR and InTELS is blank.

Lost TELS Reason (LostTELS)
Description
Required for all TELS students. This element holds the code for the reason a student
lost his/her TELS award. The student’s record level data will be reported to THEC each
semester until the student graduates or exceeds eligibility (6 years enrolled or max of
124 hours).
A—Cumulative Higher Education GPA.
B—Reached Maximum Cumulative Attempted TELS Credit Hours. The student has
reached the maximum number of hours allowed in the TELS program. This is
usually 120 hours except in a few majors.
C—24 Attempted Hours (Hope Access grant only). The student has a HOPE Access
Grant and has reached the maximum 24 attempted hours allowed by the Access
Grant.
D—Enrollment Status Change without permission. A student changed from full-time to
part-time in the semester by dropping a class. A student must be full-time to retain
the grant.
E—Non-continuous Enrollment. A student did not register for a semester causing them
to lose the grant.
F—Received Bachelor’s Degree.
G—Maximum time on TELS reached.
H—Reached 8 full-time equivalent semesters.
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O—Other – student lost the TELS award for a reason other than those listed above.
Z—Has not lost Lottery Scholarship

Valid Responses
One-letter code corresponding to categories above.

Examples
A
D

Edit
An error will be generated if a student has an InTELS date, but no award in HOPESC or
HOPEGR and LostTELS is blank.

Regain TELS Award Flag (RegainTELS)
Description
This is a single letter flag that indicates if the student has lost and regained the TELS
scholarship. ‘Y’ means the student lost and regained the scholarship, ‘N’ indicates the
student lost and has not regained the scholarship OR an ‘N’ can indicate the student
never lost the scholarship and therefore has not regained the scholarship. Required for
all TELS students.

Valid Responses
One letter code corresponding to above.

Examples
Y
N

Edit
An error will be generated if a student is receiving a TELS award and is missing a
RegainTELS value.

28

Repeat Course Affecting TELS GPA Flag (RepeatTELS)
Description
This is a single letter flag that indicates if the student has used the one time option to
replace a course that alters their TELS GPA (GPATELS). ‘Y’ indicates they have repeated
a course and that it has affected their TELS GPA, ‘N’ indicates they have not repeated a
course that affected their TELS GPA. Required for all TELS students.

Valid Responses
One letter code corresponding to above.

Examples
Y
N

Edit
An error will be generated if a student is receiving a TELS award and is missing a
RepeatTELS value.

Non-Traditional HOPE Student Flag (NonTradHOPE)
Description
This is a single letter flag that indicates if the student is receiving the HOPE
Scholarship for Non-traditional students. ‘Y’ indicates they are receiving HOPE for nontraditional students, ‘N’ indicates they are not receiving HOPE for non-traditional
students. Required for all TELS students.
In short, a non-traditional HOPE student is over the age of 25, has entered the
institution as a freshman or after not being enrolled for 2 years. The student also must
have an Adjusted Gross Income (AGI) of 36,000 or less and must have a 2.75 GPA after
12 attempted hours to qualify. Please note that this is only a summary meant to clarify
who is to be flagged Y in the NonTradHOPE field. For more detailed information, please
contact TSAC or refer to Tennessee Code Annotated § 49-4-931.

Valid Responses
One letter code corresponding to above.

Examples
Y
N

Edit
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An error will be generated if a student is receiving a HOPE award and is missing a
NonTradHOPE value. An error will also be generated if NonTradHOPE is Y and the
student’s age is less than 25.

High School Code (HSCODE)
Description
This element contains the College Board code for the students’ high school of
graduation. Required for all TELS students. College Board high school codes can be
found at https://ticua.org/page/datacollection.

Valid Responses
Numeric in form ######

Examples
122331
002111

Edit
An error will be generated if a student is receiving a TELS award, has a GRADTYPE of 1
or 2, and HSCODE is missing. An error will also be generated if the HSCODE value is
not a valid CEEB code in the form ######.

High School Diploma Type (GRADTYPE)
Description
This element contains a one-digit code for the high school diploma type. Required for
all TELS students. The codes are as follows:
1
2
3
4
5
6
7

–
–
–
–
–
–
–

High School Diploma/met A89 admission requirements
High School Diploma/did not meet A89 admission requirements
No High School Diploma
No High School Diploma/Early Admission
No High School Diploma/Dual Enrollment
GED/HiSET
Home School

Valid Responses
Number code corresponding to categories above.

Examples
2
30
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Edit
An error will be generated if a student is receiving a TELS award and GRADTYPE is
missing. An error will also be generated if the GRADTYPE value is not one of the above
codes.

High School Graduation Date (GRADDATE)
Description
This element holds the two-digit month and four-digit year of the students’ high school
graduation. Required for all TELS students.

Valid Responses
Date in form MM/YYYY.

Examples
05/2019
12/2011

Edit
An error will be generated if a student is receiving a TELS award and GRADDATE is
missing. An error will also be generated if the GRADDATE value is not a valid date.

High School GPA – (HSGPA)
Description
This is the student’s final high school GPA as reported on their transcript. Required for
all TELS students.

Valid Responses
Number with up to 2 digits to the right of the decimal place.

Examples
2.00
3.25

Edit
An error will be generated if a student is receiving a TELS award and HSGPA is missing.
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AP – Number of Advanced Placement Courses Taken (NUMAP)
Description
This element will be the number of advanced placement (AP) courses a student took in
high school. Required for all TELS students.

Valid Responses
Two digit number in form ##

Examples
10
03

Edit
An error will be generated if a student is receiving a TELS award and NUMAP is
missing.

ACT Composite Score (ACT)
Description
This is a two digit element containing the ACT composite score for the student. The
composite score is the average of the four ACT subtests rounded to an integer. Do not
report residual scores. All TELS students are required to have either an ACT or SAT
score listed.

Valid Responses
Two digit number in form ##

Examples
32
19

Edit
An error will be generated if a student is receiving a TELS award and is missing both
ACT and SAT values or if an invalid ACT score is reported.
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SAT Cumulative Score (SAT)
Description
This is a four digit element containing the cumulative SAT score for the student. All
TELS students are required to have either an ACT or SAT score listed.
As of 2017-2018, the “New SAT” score should be reported. You may use the
concordance provided by the CollegeBoard for guidance concording the old scores to the
new scores. Tools and corcordance tables can be found at
https://collegereadiness.collegeboard.org/educators/higher-ed/scoringchanges/concordance.

Valid Responses:
Four digit number in form ####

Examples
0825
1500

Edit
An error will be generated if a student is receiving a TELS award and is missing both
ACT and SAT values or if an invalid SAT score is reported.

Financial Aid
Description
The following columns deal with financial aid awarded to a student. All elements are
required for all students. It is possible to have more than one type of aid per student per
term. Report awards for the current term only. Columns are provided for the following
programs:

FEDAID

Amount of Total Federal Aid
Please note: This data element should total all federal aid awarded to
the student including but not limited to Pell Grant, Stafford Loans,
Perkins Loans, PLUS loans, SMART grants, Academic Competitiveness
Grants (ACG), Supplemental Educational Opportunity Grants (SEOG),
etc.

PELL

Federal PELL Grant

STFSUB

Federal Stafford (Subsidized) Loan

STFUSB

Federal Stafford (Unsubsidized) Loan
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STAAID

Amount of Total State Aid
Please note: This data element should total all state aid awarded to the
student including but not limited to TSAA, HOPE Access Grant, HOPE
Scholarship, General Assembly Merit Scholarship, HOPE Aspire Award,
HOPE Dual Enrollment Grants, Helping Heroes Grants, HOPE Foster
Care Grants, Ned McWherter Scholars, TSAC-Byrd Scholarship, TN
Promise, TN Reconnect, etc.

TSAAG

Amount of Tennessee Student Assistance Award Grant

HOPEGR

Amount of Tennessee HOPE Access Grant

HOPESC

Amount of Tennessee HOPE Scholarship

HOPESU

Amount of Tennessee HOPE ASPIRE Award

GMERIT

Amount of General Assembly Merit Scholarship

HOPEDU

Amount of Tennessee HOPE Dual-Enrollment Grant

HOPEFO

Amount of Tennessee HOPE Foster Care Grant

INSAID

Amount of Institutional Aid

PCAID

Amount of Private / Community Aid

TOTLOA

Amount of Total Loan Aid (including Federal)
Please note: This data element should total all loan aid awarded to the
student including but not limited to Stafford loans, PLUS loans, Perkins
loans, Private/Alternative loans, etc

Valid Responses
Numeric with two digits to the right of the decimal place.

Examples
1010.00
157.25
0.00

Edit
An error will be generated if any of the financial aid values are missing or greater than
their semester maximum award amounts (ex: PELL - $3048 per semester).
An error will also be generated if FEDAID (Total Federal Aid Award Amount) is not equal
to or greater than the sum of the other federal award amounts (PELL, STFSUB, and
STFUSB)
An error will also be generated if STAAID (Amount of Total State Aid) is not equal to or
greater than the sum of the other state financial aid awards (TSAAG, HOPEGR,
HOPESC, HOPESU, GMERIT, HOPEDU, HOPEFO, TNPROMISE, & TNRECONNECT)
An error will be generated if TOTLOA (Amount of Total Loan Aid) is not equal to or
greater than the sum of the other loan award amounts (STFSUB and STFUSB).
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Tennessee Promise Eligibility Flag (TNPROMISEFLAG)
Description
This is a single letter flag that indicates if the student is eligible for the Tennessee
Promise scholarship. ‘Y’ indicates they are currently eligible, ‘N’ indicates they are not.
Because the Tennessee Promise award is a last dollar scholarship, it is possible for a
student to be eligible for the program without receiving an award. If a student loses
eligibility for the Tennessee Promise scholarship, this flag should be ‘N’ and the
appropriate lost scholarship reason should be reported.

Valid Responses
One letter code corresponding to above.

Examples
Y

Edit
An error will be generated if the TNPROMISEFLAG is ‘Y’ and a valid lost scholarship
reason code is reported in TNPROMISELOST.

Tennessee Promise Award Amount (TNPROMISE)
Description
This column contains the Tennessee Promise scholarship amount awarded. This may
be zero if student participated in the program but received no funds. Required for
Tennessee Promise eligible students.

Valid Responses
Numeric with two digits to the right of the decimal place.

Examples
1010.00
157.25
0.00

Edit
An error will be generated if the TNPROMISE award amount is blank and the
TNPROMISEFLAG is ‘Y’. An error will be generated if the TNPROMISE award amount is
not equal to 0.00 or blank and a valid lost scholarship reason code is reported in
TNPROMISELOST.
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Tennessee Promise Lost Scholarship Reason (TNPROMISELOST)
Description
This element holds the code indicating the reason a student lost the Tennessee Promise
scholarship. For students who have not received the Tennessee Promise scholarship
this field should be blank.
Lost Scholarship Reason
Verification Incomplete
Not Enrolled
Not Enrolled Full-time
Tuition/Fees Covered By Gift Aid
Graduated
Drop from Full-time to Part-time Status
Academic Progress Not Met
Leave of Absence
Appeals Pending
Ineligible Degree
Diploma Received
Program Complete
Associate's Degree Received
Received five (5) Semesters
Not a Tennessee Resident
Other Not Listed Above

Code
N01
N02
N03
N04
N05
N06
N07
N08
N09
N10
N11
N12
N13
N14
N15
N99

Valid Responses
Three character alphanumeric code from table above.

Examples
N01

Edit
An error will be generated if the TNPROMISELOST reason code is not blank or one of
the above reason codes. An error will be generated if a valid TNPROMISELOST reason
code is reported and the TNPROMISELOST flag is ‘Y’. An error will be generated if a
valid TNPROMISELOST reason code is reported and the TNPROMISE award amount is
not 0.00 or blank.
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Tennessee Reconnect Eligibility Flag (TNRECONNECTFLAG)
Description
This is a single letter flag that indicates if the student is eligible for the Tennessee
Reconnect Grant. ‘Y’ indicates they are eligible, ‘N’ indicates they are not. Because the
Tennessee Reconnect Grant is a last dollar scholarship, it is possible for a student to be
eligible for the program without receiving an award. If a student loses eligibility for the
Tennessee Reconnect grant, this flag should be ‘N’ and the appropriate lost scholarship
reason should be reported.

Valid Responses
One letter code corresponding to above.

Examples
Y

Edit
An error will be generated if the TNRECONNECTFLAG is ‘N’ and no value exists in
TNRECONNECTLOST.

Tennessee Reconnect Award Amount (TNRECONNECT)
Description
This column contains the Tennessee Reconnect Grant amount awarded. This may be
zero if student participated in the program but received no funds. Required for
Tennessee Reconnect students.

Valid Responses
Numeric with two digits to the right of the decimal place.

Examples
1010.00
157.25
0.00

Edit
An error will be generated if the TNRECONNECT award amount is blank and the
TNRECONNECTFLAG is ‘Y’. An error will be generated if the TNRECONNECT award
amount is not equal to 0.00 or blank and a valid lost scholarship reason code is
reported in TNRECONNECTLOST.
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Tennessee Reconnect Lost Scholarship Reason
(TNRECONNECTLOST)
Description
This element holds the code indicating the reason a student lost the Tennessee
Reconnect Grant. For students who have not received the Tennessee Reconnect Grant
this field should be blank.
Lost Scholarship Reason
Verification Incomplete
Not Enrolled
Not Enrolled Full-time
Tuition/Fees Covered By Gift Aid
Graduated
Drop from Full-time to Part-time Status
Academic Progress Not Met
Leave of Absence
Appeals Pending
Ineligible Degree
Diploma Received
Program Complete
Associate's Degree Received
Received five (5) Semesters
Not a Tennessee Resident
Other Not Listed Above

Code
N01
N02
N03
N04
N05
N06
N07
N08
N09
N10
N11
N12
N13
N14
N15
N99

Valid Responses
Three character alphanumeric code from table above.

Examples
N01

Edit
An error will be generated if the TNRECONNECTLOST reason code is not blank or one
of the above reason codes. An error will be generated if a valid TNRECONNECTLOST
reason code is reported and the TNRECONNECTLOST flag is ‘Y’. An error will be
generated if a valid TNRECONNECTLOST reason code is reported and the
TNRECONNECT award amount is not 0.00 or blank.
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How to Utilize the Enrollment Checking Program
In order to make the enrollment reporting process easier for both TICUA and our member
institutions, a program was created in Visual BASIC for Applications (VBA) to use for checking
enrollment data files for errors in a quick and automatic way.
It is not a standalone application like a traditional program (meaning, you do not run it by
double-clicking an .EXE file) – rather it is a compilation of VBA code that the user can insert
into their spreadsheet and run like an MS Office macro.

Running the Checking Program
Visit the TICUA Research / Data Collection page at https://ticua.org/page/datacollection and
download the latest version of the Enrollment Reporting Template. The template has the
checking program embedded as a macro. If you wish to import the code into your own file,
skip down to the “How to import the code into your spreadsheet” section.
Now that the code is in the worksheet, you can run the program just like any Office macro. In
Excel, click the Developer tab, then select Macros. This will bring up a menu similar to the
one below. (If you do not see a Developer tab, you can add it by right-clicking on the ribbon and
selecting “Customize the Ribbon”. From here, you will check the box next to “Developer” to add
the Developer tab.)

[Image 1 - Macro selection menu]

The worksheet (note: work*sheet*, not work*book* – the name of the workbook (the filename)
doesn’t matter in this case) containing your report must be titled “Enrollment” or the program
will generate a “Subscript Out of Range” error.
Make sure that the first column in your spreadsheet is the “FICECODE” column and not the
“Questions” column from any previous runs of the program– or else it will insert a second
“Questions” column and problems will ensue.
Select the ThisWorkBook.CheckEnrollment macro from the menu and click Run.
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The program will then proceed to run, running formatting and data checks. It may take a few
minutes, depending on the speed of your computer and the number of records in the file.
Should all go as planned, and no errors encountered, you should see a pop-up box stating that
“Enrollment checking is completed”. A column titled “Questions” will be inserted at the
beginning of the file. This column will contain any error messages relating to the record
contained in that row.
Should you edit a record and need to re-run the program, simply delete the “Questions”
column and repeat the steps above, from the point of clicking Macros on the Developer tab.
Make sure to delete the ‘Questions’ column or errors may result!

Data Tips for Successfully Running the Enrollment Checking
Program
The following errors are common yet easily fixed:
Yes/No fields such as RegainTELS, RepeatTELS, & NonTradHOPE for TELS students should
not be left blank. If the value is No or False make sure that a ‘N’ is reported. Blank values are
interpreted as missing/unknown and missing data errors will result.
Along these same lines, the financial aid award fields (from FEDAID to TOTLOA) should not be
left blank, instead report a zero for students who have not been awarded a particular type of
aid. Otherwise, missing data errors will result.

How to import the code into your spreadsheet
If you are not using the Enrollment Reporting Template, download the latest version of the
Enrollment Data Checking Program (also available on the data collection page) and follow the
steps below.
It is very important that the version of the template and the version of the program that you are
using match. The columns in your worksheet must match the order of the columns found in
the ‘Blank Enrollment Report’ sheet – if not the checks and formatting will be performed on the
wrong columns and result in false errors.
Once downloaded, open the .VB file with a text editor, such as Notepad. It should look
something like the below picture:

[Image 2 - .VB file opened with Notepad]
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Now click Edit->Select All, then click Edit->Copy (while these directions are written for
Notepad, the process is often the same in different programs – basically, what you’re doing it
selecting the entire file and copying it to the Clipboard)
Open the Excel file containing your enrollment report. Rename the worksheet containing your
data to “Enrollment”.
Enable the Developer tab if it is not enabled. To do this, right click the ribbon and select
“Customize the ribbon”. Check the box next to Developer, then click OK and you are ready to
go. Once the Developer tab is enabled, open the Visual Basic Editor by selecting the Developer
tab, then Visual Basic.
The Visual Basic Editor should open and look something like the picture below.

[Image 3 - The Visual BASIC Editor]

Make sure that the workbook titled “ThisWorkbook” is selected, on the left-hand side of the
screen. If not, double click it to select it.
If there is any existing code from older versions of the program already in the file, you’ll need to
select it all and delete it. (If there is code from something other than the enrollment checking
program, you probably won’t want to delete it)
Click Edit->Paste to paste the program code into your worksheet. Now you can close the editor
window by clicking the “X” in the top right of the screen, or by clicking File->Close and
Return to Microsoft Excel.
From here, follow the directions in the “Running the Checking Program” section above.
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